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1. Introduction to Kernel for Notes Calendar to 

Outlook 

Welcome to the user manual for Kernel for Notes Calendar to Outlook, the most effective and convenient 
Lotus Notes Calendar Items migration tool to migrate/export Notes Calendars to MS Excel and MS 
Outlook. This user manual comprises step by step guidelines on using Kernel for Notes Calendar to 
Outlook software. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Notes Calendar to Outlook. We suggest 
that first time users should read this user manual completely and carefully before proceeding to use the 
software. However, if you are an experienced user, you can use the table of contents to find out 
information pertaining to the tasks that you need to perform by using Kernel for Notes Calendar to 
Outlook. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Converting Calendar items from .NSF file 

 Converting Calendar Items from Lotus Domino Server Mailbox 

 Saving Converted Files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 
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NSF: Notes System File 

XLS: Excel sheet 

PST: Personal Storage File 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

1.2 About Kernel for Notes Calendar to Outlook 

Kernel for Notes Calendar to Outlook is a Lotus Notes Calendar Items migration tool to migrate/export 
Notes Calendars to .XLS or .PST files. 

Easily export calendar entries of Lotus Notes .NSF files or through Lotus Domino Server. Kernel for Notes 
Calendar to Outlook directly gets connected to the User mailbox on Lotus Domino Server and lets you 
select and convert .nsf file. Calendar items created and saved in any folder are converted easily by the 
software. 

1.3 Salient Features 

Salient features of Kernel for Notes Calendar to Outlook include: 

 Converts unlimited calendar entries at once 

 Supports migration of Calendar items direct from Lotus Domino Server 

 Saves converted calendar items in PST or Excel files 

 Free evaluation software allows to save first 10 Calendar items 

 Supports every version of Lotus Notes, MS Outlook, Lotus Domino Server and MS Excel for 
conversion 

1.4 Who Should Use this Software? 

The capability of Kernel for Notes Calendar to Outlook to convert calendar items to Outlook and display 
calendar items of Lotus Notes with MS Outlook and MS Excel makes it the preferred choice of 
Organizations/Companies/Individuals, who need to export the calendar items of their employees from their 
Notes User mailboxes to other viewable medium like MS Outlook or MS Excel worksheet. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for Notes Calendar to Outlook, you are 
ready to get hands on experience of the software. To start conversion process, you will first need to 
download and install Kernel for Notes Calendar to Outlook. 

It is strongly recommended that before installing Kernel for Notes Calendar to Outlook, you should go 
through the installation pre-requisites for the software to ensure that your computer is appropriately 
configured to run the software. 

2.1 Installation Pre-requisites 

Kernel for Notes Calendar to Outlook works on all Windows-based computers. Following are detailed 
installation pre-requisites for the host Computer: 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements, Lotus Notes, Lotus Domino Server version requirements. 

The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported Operating Systems: 

 Windows Vista 

 Windows XP 

 Windows 2000 

 Windows 2003 

2.1.2.2 Lotus Notes Version Requirements 

Supported Lotus Notes versions: 
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 Lotus Notes 8.0 

 Lotus Notes 7.0 

 Lotus Notes 6.5 

2.1.2.3 Lotus Domino Server Version Requirements 

Supported Lotus Domino Server versions: 

 Lotus Domino Server 8.0 

 Lotus Domino Server 7.0 

 Lotus Domino Server 6.5 

2.1.2.4 MS Outlook Version Requirements 

Supported MS Outlook versions: 

 MS Outlook 97 

 MS Outlook 98 

 MS Outlook 2000 

 MS Outlook 2002 

 MS Outlook 2003 

 MS Outlook 2007 

2.1.2.5  MS Excel Version Requirements 

Supported MS Excel versions: 

 MS Excel 97 

 MS Excel 98  

 MS Excel 2000 

 MS Excel 2002 

 MS Excel 2003 

 MS Excel 2007 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

2.2 Downloading Kernel for Notes Calendar to Outlook for the First 
Time 

After checking your computer with the prescribed system requirements for Kernel for Notes Calendar to 
Outlook, you can download and install the software on your computer. You can buy the full version of the 
software from any one of our authorized resellers – Element5, Asknet and 2CO. 

If you want to try using Kernel for Notes Calendar to Outlook before buying it, you can download the 
evaluation version from the following link: 

http://www.nucleustechnologies.com/download-notes-calendar-to-outlook.php 

 You can convert Notes Calendar from .NSF File saved on your system or directly 
from the Lotus Domino Server by using the evaluation version of Kernel for Notes 
Calendar to Outlook; however, you will not be able to save every converted calendar 
entry until you purchase the full version of the software. 

2.3 Install Kernel for Notes Calendar to Outlook 

After downloading the installer file for Kernel for Notes Calendar to Outlook, you can install the software by 
running the file. To install Kernel for Notes Calendar to Outlook, 

1. Double-click the Kernel for Notes Calendar to Outlook installer. Follow the on-screen instructions. 
The Setup Installation Complete screen will be displayed. 

2. Click Finish to launch the software. 

2.4 Start Kernel for Notes Calendar to Outlook 

To start Kernel for Notes Calendar to Outlook: 

Click the Start  All Programs Kernel for Notes Calendar to Outlook 

Alternatively, you can launch Kernel for Notes Calendar to Outlook by double-clicking the shortcut icon 
available on the Desktop and Quick Launch section. 

2.5 Uninstall Kernel for Notes Calendar to Outlook 

You may need to uninstall Kernel for Notes Calendar to Outlook. To uninstall Kernel for Notes Calendar to 
Outlook: 

1. Click the Start  All Programs Kernel for Notes Calendar to Outlook  Uninstall Kernel for 
Notes Calendar to Outlook 

A warning message will be displayed. 

2. Click Yes to uninstall Kernel for Notes Calendar to Outlook. 

http://www.nucleustechnologies.com/download-notes-calendar-to-outlook.php
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 Before proceeding to uninstall Kernel for Notes Calendar to Outlook, you must 
ensure that the software is not running on your system. 

You can alternatively uninstall Kernel for Notes Calendar to Outlook from the Control Panel by performing 
the following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Notes Calendar to Outlook and click Remove. A warning message will be 
displayed. 

3. Click Yes to uninstall Kernel for Notes Calendar to Outlook. 
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3. Software Interface 

Now that Kernel for Notes Calendar to Outlook has been installed on your computer, you can start using 
the software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Notes Calendar to Outlook comprises two main menus – File and Help. 

3.1.1 File Menu 

The File menu comprises four menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add File(s) Opens the Open window to select and list the .NSF file 

Add Domino 
File(s) 

Opens Lotus Domino Server file selection window 

Export Opens the Save Options window 

Exit Close Kernel for Notes Calendar to Outlook 

3.1.2 Help Menu 

The Help menu comprises three menu items. 

 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

 

Figure 3.2: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Software Help Displays the user manual of Kernel for Notes Contacts to 
Outlook 

Software Homepage Select to visit software homepage on our website 

About Kernel for Notes 
Calendar to Outlook 

Select to view version-related and support information of 
Kernel for Notes Calendar to Outlook 

3.2 Tool-bar 

The tool-bar in Kernel for Notes Calendar to Outlook is displayed below the menu-bar. The tool-bar 
provides a convenient and user-friendly method to perform certain actions that can also be performed by 
using the menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

 

Button Button Name Button Description 

 

 

Select File(s) Opens the Open window to select and list the 
.nsf file from your system 

 

 

Add Domino 
File(s) 

Opens the Lotus Domino Server file selection 
window 

 

Export Opens the Save options window 
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Help Displays User Manual of Kernel for Notes 
Calendar to Outlook 

 

 

Buy Online Purchase the software online from the website 

3.3 Status-bar 

Status bar is displayed at the bottom of the software window. The text „www.nucleustechnologies.com‟ is 
displayed on the status bar when you open the software. 

Text on the status bar changes according to the actions which are performed with the tool bar buttons The 
Status bar also displays the text „CAP‟, „NUM‟, „SCRL‟ which respectively correspond to the Caps Lock, 
Num Lock, and Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the 
corresponding text will turn blue/black. 

 

Figure 3.3: Status Bar 

3.4 Customize User Interface 

You can add or remove toolbar buttons by clicking: 

Add or Remove ButtonsStandard in the toolbar and selecting appropriate buttons. 
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4. Converting Calendar Items from .NSF File 

Now that you have complete familiarity of the user interface of Kernel for Notes Calendar to Outlook, you 
are ready to convert calendar items from NSF file. 

To convert items from .NSF file: 

1. Launch Kernel for Notes Calendar to Outlook. 

2. Click the Add File button. Open window to select the .nsf files will appear. 

3. Select the .nsf file and click the Open button to list the file in software. 

4. Click the Preview button to view preview of the calendar items existing in the .nsf file before saving 
them or click the Export button to save the converted calendar items in .PST or .XLS file. 

5. When you click the Preview button, software displays preview of the converted calendar items before 
saving them. 

6. Click the Export button to view the Save Options window. 

7. Kernel for Notes Calendar to Outlook provides two saving options to save the converted calendar 
items: Save in PST or Save in Excel File. 

 Save in PST: Saves the calendar entries to new or existing PST file. 

 Save in Excel File: Saves the calendar entries to new .XLS file. 

 Export Calendar to single file (Applicable only if you are exporting multiple NSF 
files): Check this checkbox when you want to save calendar items of multiple .nsf 
files in to single PST or XLS file. 
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5. Converting Calendar Items from Lotus Domino 

Server Mailboxes 

Kernel for Notes Calendar to Outlook software enables the administrators to convert calendar items 
directly from the NSF file from mailboxes on Lotus Domino Server. Access Domino server with the help of 
Kernel software and convert the Calendar Items of Notes to Outlook or Excel file. 

1. Launch Kernel for Notes Calendar to Outlook software. 

2. Click the Add Domino File button. Domino Server File Selection window will appear to define the 
Domino Server settings. 

 

Figure 5.1: Domino Server File Selection 

3. Click the Add Domino Server button to define the Domino Server name. 

4. Click the Search Domino Server button to search for available domino server (s) in network. 
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5. Domino server file selection window appears when button to search Domino Server is clicked. 

6. Kernel software asks for the ID file password to access the Domino server user mailbox. Provide the 
password to Kernel software and click the OK button. 

 

Figure 5.2: Domino Server File Selection 

7. Domino server name will get listed in the software. 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

 

Figure 5.3: Domino Server File Selection 

8. Select the user-mailbox.nsf file and click the Add button to list the files in software and click the Finish 
button to close the window. 

9. Select the file which you want to save and click the Export button to continue with the saving process. 
Kernel software will display the Save Options window and ask to define the save options: PST or 
Excel. 

10. Kernel for Notes Calendar to Outlook provides two saving options to save the converted calendar 
items. 

10.1 Save in PST: Saves the calendar entries to new or existing PST file. 

10.2 Save in Excel File: Saves the calendar entries to new .XLS file. 

 Export Calendar to single file (Applicable only if you are exporting multiple nsf 
files): Check this checkbox when you want to save calendar items of multiple .nsf 
files in single PST or XLS file. 
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6. Saving Converted Files 

Once all the calendar entries are extracted by Kernel for Notes Calendar to Outlook, you are ready to save 
the extracted calendar entries. 

6.1 Save in PST 

To save the file in pst, follow these simple steps: 

 Click the Save in PST radio button. 

 Define the PST file settings. 

Save in New File: If you want to save the converted items in any new PST file, you need to define these 
fields: 

1. PST Folder Path: The PST file path location where you want to save the file on your hard drive. 

2. PST File Name: The name of the PST files which you are saving. 

Save in Existing File: If you want to save the converted items in any existing PST file, define the path of 
the existing PST file, where you want save the file. 

 Kernel for Notes Calendar to Outlook will start the saving process. After successful saving process, 
Kernel software will display a “saving complete” message. 

6.2 Save in Excel 

To save in Excel file, follow these simple steps: 

 Click the Save in Excel File radio button on Save Options Window. 

 Define Excel folder path and Excel file name. 

 Kernel for Notes Calendar to Outlook will start the saving process. After successful saving process, 
Kernel software will display a “saving complete” message. 
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7. Full version 

Although you can use Kernel for Notes Calendar to Outlook evaluation version for free and experience 
capabilities of the software, there are certain features that are not available in the evaluation version. 

7.1 Requirement of Full Version 

The free to evaluate demo version of Kernel for Notes Calendar to Outlook software is fully functional in its 
conversion capabilities. It will convert your notes calendar to .PST file and .XLS and will show preview of 
the converted calendar items with data. But due to demo limitations, Kernel for Notes Calendar to Outlook 
converts single .nsf file and saves only first 5 calendar items per folder, which exists in the nsf file. 

For complete saving of calendars, you will need to buy full version of the software. 

7.2 Purchasing Full Version 

You can buy the full version of Kernel for Notes Calendar to Outlook from any one of our authorized 
resellers – Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our Sales team will send you an email 
comprising the URL to download the full version of Kernel for Notes Calendar to Outlook and activation 
details of the software. 
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8. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Notes Calendar to Outlook. The software comes with an embedded help manual that 
can be accessed by clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on the 
keyboard of your computer to access the embedded help of Kernel for Notes Calendar to Outlook. 

You can access the online help for Kernel for Notes Calendar to Outlook at 
http://www.nucleustechnologies.com/Online-Helps.html 

View Animated Working demo of the software to get an overview of all the features and functions of the 
software:  
http://www.nucleustechnologies.com/Animated_Demo_Notes_Calendar_to_Outlook.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html . 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Animated_Demo_Notes_Calendar_to_Outlook.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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9. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Notes Calendar to 
Outlook. 

9.1 Common Issues 

Why does Kernel for Notes Calendar to Outlook have limitations in evaluation copy? 

The free evaluation version of Kernel for Notes Calendar to Outlook is intended to enable you to 
experience the capabilities of the software. With demo version of the software, you can convert calendar 
items of single .nsf file and save first five calendar items per folder which exists in the .nsf file. You will 
need to buy the software to perform complete conversion and saving. 

9.2 Frequently Asked Question 

How to Buy Kernel for Notes Calendar to Outlook? 

You can buy Kernel for Notes Calendar to Outlook online at http://www.nucleustechnologies.com/buy-
notes-calendar-to-outlook.php  

I have lost my full version for Kernel for Notes Calendar to Outlook. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

  

http://www.nucleustechnologies.com/buy-notes-calendar-to-outlook.php
http://www.nucleustechnologies.com/buy-notes-calendar-to-outlook.php
mailto:sales@nucleustechnologies.com
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10. Legal Notices 

This section comprises the legal specification about Kernel for Notes Calendar to Outlook and the 
company NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

10.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

10.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, MS Outlook, MS Excel, MS-DOS, MS 
Exchange Server and Lotus Notes, Lotus Domino Server are registered trademarks of Microsoft 
Corporation and IBM. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

10.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

10.4 License Agreement 

Kernel for Notes Calendar to Outlook Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
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each Licensed Copy of Kernel for Notes Calendar to Outlook. For purposes of this License, if you have a 
valid license, you have the right to use a single Licensed Copy of Nucleus Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Notes Calendar to Outlook may either be used by a single person or 
used non-simultaneously by multiple people who use the software personally installed on a single 
workstation. All rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You 
may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative 
works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus 
Kernel available to others in connection with a service bureau, application service provider, or similar 
business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Notes Calendar to Outlook, and any and all accompanying software, files, data and materials, 
are distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Kernel for Notes Calendar to Outlook in applications or systems 
where Kernel for Notes Calendar to Outlook failure to perform can reasonably be expected to result in a 
significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or losses 
relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


